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LUCRAREA 6. Prezentari multimedia. Microsoft PowerPoint

Tema 1: Crearea unei prezentiri PowerPoint folosind sabloane (Template) si teme (Theme)

1.1. Creafi o noua prezentare PowerPoint folosind un sablon (Zemplate) la alegere. Prezentarca va
folosi textul disponibil in fisierul monifor.doc situat in acelasi folder cu acest document g1 va fi
formata din 7 slide-uri cu urmatoarea structura (respectati layout-urile indicate):

- Slide 1 (layout: Title Slide): titlul prezentarii + autor (numele, grupa)

- Slide 2 (layout: Content with Caption): cuprinsul prezentarii

- Slide 3-7 (layout: Title and Content): slide-uri corespunzatoare celor 5 capitole (Introducere,

Tehnologii, Specificatii tehnice, Rezolutii, Evolutie pret).

R:
In Microsoft PowerPoint se foloseste meniul File -> New, de unde se alege un sablon.
Se introduc succesiv gi celelalte 6 slide-uri (meniul Home -> grupul Slides, buton New Slide sau din
meniul contextual daca se did click dreapta pe imaginea in miniaturd a slide-ului), alegandu-se
macheta (lavout) indicata (fie la creare, fie ulterior cu butonul Layout):
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Se¢ observa ca primul slide are implicit layout-ul Title Slide. Dupa ce ati creat slide-ul 3 cu layout-ul
corespunzitor, acesta se poate duplica rapid (click dreapta ->> Duplicate Slide sau trigand cu mouse-ul
in jos si apdsand tasta Ctrl). Se observi ci prin operatia Drag & Drop (tragere cu mouse-ul) se poate
schimba ordinea slide-urilor in prezentare.

1.2. Aplicati tuturor slide-urilor tema Retrospect. Modificati apoi aspectul temei alegand diverse
valori pentru culorile textului, fonturile, efectele gi fundalurile.

R:

Se foloseste meniul Design -> grupul Themes pentru a vedea mai multe teme disponibile (s¢ tine
cursorul mouse-ului deasupra fiecdrei teme pentru a se identifica tema Retrospect) s1 grupul Variants
pentru a modifica aspectul temei.
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Din acelasi meniu se poate aplica o temd unei prezentari existente sau tema curentd (cu toate setdrile
ficute) poate fi salvata pentru o utilizare ulterioard, ca fisier sablon (format .potx) sau ca tema Office
(extensia .thmx), tema ce poate fi aplicata si altor documente (Word sau Excel).

Tema 2: Continutul unei prezentari PowerPoint

2.1. Completati slide-urile cu informatiile din documentul monitor.doc preluate cu Copy & Paste.
Fiecare slide va contine titlul capitolului si informatiile corespunzitoare (text, liste, tabele).

R:

Se selecteazd informatiile de la fiecare capitol si se transfera in slide-urile corespunzitoare prin Copy
(Ctrl+C) s1 Paste (Ctrl+V).

2.2. Inserafi in slide-ul 4 (T ehnologii) imaginile monitor crt.jpg, monitor led jpg. monitor plasmar Jjpe

.....

R:
Pentru inserarea imaginilor se foloseste meniul Insert -> grupul Images, buton Pictures. Apoi se
selecteaza cele 3 imagini si se foloseste meniul Picture Tools - Format si grupul Size -> caseta Width.

23. Inserafi in  slide-ul 3 (Umtroducere) video-ul de la  adresa  Web
hitp://www.voutube.com/watch?v=wavRenbreFc sau folositi fisierul samsung.mp4 din folder-ul
acestui document.

R:

Inserare video: meniul Insert -> grupul Media, buton Video. Se poate alege Online Video (pentru
fisiere video stocate in contul personal de pe OneDrive, pe site-ul Youtube sau pe alt site, dacd se
introduce codul HTML pentru inserare - Embed Code) sau un fisier stocat local pe calculator (Video
on My PC)

{)
Video Audio

- -

Media

Exemple de Embed Code pentru video-ul de mai sus:
1. Folosind marcajul <iframe>:
<iframe  width="560" height="315" src="//www.voutube.com/embed/wayRen6reFc”
frameborder="0" allowfullscreen></iframe>
2. TFolosind marcajul <object>:
<object width="560" height="315"><param name="movie"
value="//www.youtube.com/v/wayRenbreFc?version=3&amp;hl=en US"></param><param
="allowscriptaccess"

name="allowFullScreen" value="true"></param><param name
value="always"></param><embed
sre="//www.youtube.com/v/wayRcn6reFc?version=3&amp:hl=en US" type=
shockwave-flash" width="560" height="315" allowscriptaccess="always"
allowfullscreen="true"></embed></object>
Observatie: pentru ca aceste coduri sa funcfioneze este necesard indeplinirea unor cerinte software
disponibile aici. In cazul in care PowerPoint afiseazd un mesaj de eroare, inserafi figsierul video
samsung.mp4.

application/x-

2.4. Inserati in slide-ul 7 (Evolutie pret) graficul disponibil in fisierul monitor.xls.
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R:
Inserare grafic: prin Copy & Paste din fisierul Excel monitor.xls.

2.5. Vizualizati prezentarea pe tot ecranul (Slide Show) folosind una din metodele:
- meniul Slide Show -> grup Start Slide Show, buton From Beginning;
- click pe butonul Start from Beginning (aflat in bara Quick Access din partea de sus a interfefei
grafice);
- click pe butonul Slide Show de pe Status Bar (in partea de jos a interfetei grafice);
- apédsand tasta IS (prezentarea incepe de la primul slide) sau Shift+F5 (prezentarea incepe de
la slide-ul curent).
Vizualizati si alte optiuni disponibile in meniul Slide Show.

R:
Meniul Slide Show contine comenzi importante pentru setarea generala a unei prezentari PowerPoint:
- crearea unei prezentdri particularizate, cu altd ordine de prezentare a slide-urilor;
- modul de prezentare a slide-urilor (avans manual sau conform timpilor alocafi);
- dispozitivul de iesire folosit (monitor si/sau videoproiector),
- utilizarea modului Prezentator (afisarea unor notite pe ecranul prezentatorului);
- inregistrarea timpilor de afisare pentru fiecare slide in vederea incadrarii intr-un interval
impus;
- inregistrarea unui comentariu audio.
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Start the show from the first slide.

Tema 3: Legituri (Hyperlinks) si actiuni (Actions)

3.1. in slide-ul 7 (Evolutie pref) introduceti urmitoarele hyperlink-uri:

- textul "Specificatii tehnice Samsung T24D390EW" -> link spre fisierul monitor.pdf (din

acelasi folder),

- textul "Site-ul producitorului” -> link spre http://www.samsung.com.
R
Se selecteaza succesiv textele care vor deveni hyperlink-uri si se foloseste meniul Insert -> grupul
Links, butonul Hyperlink. Se observa posibilitateca de a introduce un hyperlink atat spre o resursd
locald (un figier stocat pe hard-disk), cat si spre o resursd online (in acest caz trebuie specificat
obligatoriu protocolul folosit pentru accesarea resursel, uzual "Awp" - Hypertext Transfer Protocol).
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3.2. In slide-ul 2 (Cuprins) introduceti actiuni (Action) pentru cele 5 capitole, care sa faci saltul spre
slide-urile corespunzitoare cand se dd click pe ele in modul de vizualizare a prezentirii pe tot ecranul
(de exemplu, la click pe Tehnologii sa se afigeze slide-ul 4).

R:

Inserare actiuni spre slide-uri: meniul Insert -> grupul Links, butonul Action. La click de mouse
(Mouse Click) sau la mouse deasupra (Mouse Over), unui element 1 se poate stabili o actiune: salt
spre un anumit slide (din aceeasi prezentare sau dintr-o altd prezentare), un alt fisier, de orice tip, de
pe discul local sau din reteaua locala, o adresa Internet, executarea unui program etc.
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Observatie: un salt spre un alt slide se poate realiza §i prin inserarea unui hyperlink ca la punctul 3.1.:
in partea stanga a ferestrei Insert Hyperlink se selecteaza "Place in This Document" 1 apoi se alege
slide-ul destinatie.

Tema 4: Efecte de animatie pentru obiecte

Aplicafi diverse efecte de animatie celor 3 imagini din slide-ul 4. Folositi Animation Pane pentru a
modifica proprietitile animatiilor (ordinea de animare a obiectelor, sincronizarea, durata, intarzierile,
modul de desfagurare a animatiei gi alte optiuni).

R:

Se selecteazid una cite una imaginile din slide-ul 4 si din meniul Animations -> grup Animation se
aplici un efect de animatie (sau se foloseste butonul Add Animation din grupul Advanced
Animation). Butonul Preview permite pre-vizualizarea rapida a animatiilor in modul de lucru Normal.

FILE HOME INSERT DESIGN TRANSITIONS ANIMATIONS SLIDE SHOW REVIEW VIEW DEVELOPER Acrobat
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Preview Animation

Cele 4 tipuri de efecte sunt: intrare (Entrance), evidentiere (Emphasis), iesire (Exit) $i cai de migcare
(Motion Path). Fiecare categorie afiseaza efectele de bazd, insa mai multe efecte sunt disponibile daca
se executa comenzile More Effects.

* 2 Animation Pane Start: |On Click * | Reorder Animation
i Trigger~ Y Duration: (0200 .| & MoveEarlier
e P e ¥+ Animation Painter | @ Delay: 00,00 - | ¥ Move Later
Advanced Animation Timing

Butonul Animation Pane deschide un panou in care apar efectele de animatie aplicate, posibilitatea
de ordonare a animatiilor i diverse alte optiuni asociate (efecte, temporizare, sunete). Aceste optiuni
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pot fi modificate dacd se folosesc butoanele din meniul Animations -> grupul Advanced Animation
st grupul Timing sau sdgeata = din colful dreapta-jos al grupului Animation.

O o
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Tema 5: Tranzitii intre slide-uri

Aplicat diverse efecte de tranzitie la trecerile intre slide-uri (fie acelasi efect pentru toate slide-urile,
fie efecte diferite pentru anumite slide-uri selectate). Stabilifi ca trecerea de la slide-ul 1 la slide-ul 2
sd se faca automat dupd 3 secunde (nu la click de mouse).

R:

Din meniul Transitions -> grupul Transition to This Slide se alege efectul vizual dorit la trecerea de
la un slide la altul, 1ar din grupul Timing diverse proprietifi ale acestui efect (durata tranzitiei, efectul
sonor, avansul la mouse click si/sau automat dupd un numair de secunde). Tranzitia se poate aplica
slide-ului curent (implicit), mai multor slide-uri selectate anterior sau tuturor slide-urilor din
prezentare (butonul Apply To All). Butonul Preview permite pre-vizualizarea rapidi a tranzitiilor in
modul de lucru Normal. Prezenta unei animatii sau tranzitii pe un slide este indicatd de simbolul *
situat sub numarul slide-ului din vizualizarea in miniaturd (partea stingd a interfeter).
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Tema 6: Antet si subsol (Header & Footer)
Inserati in partea de jos a prezentirii (Ifooter), pe fiecare slide (cu exceptia primului slide),
urmitoarele informatii:

- Autor, grupa (in centru),

- Numdrul slide-ului curent (in dreapta).
Doar pentru primul slide inserati in footer data curentd astfel incat s se actualizeze automat la
deschiderea prezentarii.
R:
PowerPoint permite addugarea unor informatii suplimentare (data si ora, numarul slide-ului, un text
la alegere) doar in partea de jos a slide-urilor (zona Foofer), in partea de sus (Header) este posibila
adaugarea acestor informatii doar in varianta tipérita a prezentirii (Handouts) sau in varianta notelor
pentru autor (Notes Page).



Software pentru birotica www.euroqual.pub.ro

Pentru adaugarea unui subsol la un slide se foloseste meniul Insert -> grupul Text, butonul Header &
Footer.
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Se bifeaza optiunile "Slide number” s1 "Footer", iar in caseta text se completeaza informatiile
specificate (textul care si apard in centrul zonei de jos a slide-ului). Pentru ca textul din subsol si nu
apara in slide-ul titlu al prezentarii (primul slide) se bifeaza caseta "Don 't show on title slide". Pentru
a afiga informatiile numai pe slide-ul curent se apasa "Apply", iar pentru a afiga informatiile de subsol
pe toate slide-urile din prezentare se apasi "Apply to all". Pentru data pe primul slide, acesta se
selecteaza si se bifeaza Date and time -> Update automatically, dupa care se da click pe Apply.
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Tema 7: Slide Master
Folosind meniul View -> Slide Master, modificati layout-ul de tip Title and Content (folosit de
slide-urile 3-7) adaugand in partea din dreapta-sus o formd (Shape) din categoria buton actiune

(Action Button) de tip Home = La click pe acest buton, in timpul prezentarii pe tot ecranul, se va
afiga slide-ul 2 (Cuprins).

R:
Slide Master este slide-ul din varful ierarhiei de slide-uri, care stocheazi informatii despre tema
folosita si machetele celorlalte slide-uri din prezentare (fundaluri, culori, fonturi, efecte, pozitionarea
diverselor elemente). Se vizualizeaza Slide Master (meniul View -> grupul Master Views, buton Slide
Master). Se selecteaza sablonul Title and Content (a 3-a imagine miniaturd de sus in jos) si se
insereaza (meniul Insert -> grupul Illustrations, butonul Shapes, categoria Action Buttons) in partea
din dreapta-sus un buton de tip Home cu hyperlink spre slide-ul 2 (Cuprins).

Slide Handout MNotes l’"'lf:ti':iﬁ Buttgns
Master Master Master

Master Views IE @ [E‘ E Ej lj {i\[

Toate slide-urile care folosesc sablonul de tip 7itle and Content (slide-urile 3-7) vor avea acest buton
pe fundalul prezentarii (acest buton se poate modifica dacd se reintrd in modul de vizualizare Slide
Master g1 se selecteaza sablonul Title and Content).

Intrebari
1. Ce optiuni trebuie setate pentru ca prezentarea sa se desfagoare continuu, farad interventia unui
utilizator (de exemplu, o prezentare in vitrina unui showroom)?
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2. Cum se poate modifica fundalul unei prezentéri? O imagine de pe disc poate fi setati ca fundal
de slide?

Ce sunt notele autorului?

4. Ce diferente exista intre Hyperlink i Action?

i

R:
1. Trebuie setate urmitoarele optiuni:
- intre slide-uri trecerea sa se faca automat dupa un numar de secunde (meniul Transitions ->
grupul Timing, Advance Slide - After x sec, iar On Mouse Click trebuie debifat),
- pentru a relua prezentarea de la capit se bifeaza Loop continously until 'Esc’ (in meniul Slide
Show -> grupul Set Up, buton Set Up Slide Show).

2. Fundalul unei prezentari se modifica din meniul Design -> grupul Customize, butonul Format
Background. Pe fundal se poate aplica o culoare uniforma, un gradient de culoare, o textura, o hasura
sau o imagine (de pe discul local sau online, folosind motorul de cautare Bing).

3. Notele autorului (se activeazi din meniul View -> Notes page sau in modul de lucru Normal,
butonul Notes de pe Status Bar) sunt texte vizibile doar pe monitorul prezentatorului, ce pot fi folosite
pentru realizarea unei prezentari cursive.

Uzual, o prezentare PowerPoint se afigeaza pe monitorul prezentatorului (de exemplu, pe laptopul
sdu), iar pentru o audientd numeroasi, simultan pe un videoproiector conectat la laptop. Presenter
View (figura de mai jos) este un mod de vizualizare care faciliteazad rolul prezentatorului, oferind
informatii despre timpul scurs, un preview al urmétorului slide, o zoni cu notele autorului, accesul la
taskbar si la alte functii, toate acestea invizibile audientei, care vede doar prezentarea propriu-zisa. In
cazul unui singur monitor s¢ poate testa functionalitatea Presenter View folosind combinatia de taste
Alt+F5. Pentru 2 surse de iesire se bifeazd Use Presenter View (meniul Slide Show -> grupul
Monitors).

Monitorul

4. Desi sunt oarecum similare, Hyperlink si Action au si optiuni specifice:

Hyperlink | Action
Facilitati | - legaturi spre orice tip de figier de pe discul local sau din reteauva locala
comune - legéturi spre o adresd Web sau spre o locatie din documentul curent (un anumit slide,

o prezentare particularizatd - Custom Show)
- executarea unui program (hyperlink citre un executabil sau Action - Run program)

7
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Hyperlink

Action

Facilitati
specifice

- hyperlink-ul functioneaza doar la Mouse
Click (click pe link-ul respectiv)

- creeazd un link cétre un document nou ce
poate fi editat acum sau ulterior

- creeazd o legiturd spre o adresd e-mail

- actiunea are loc atat la Mouse Click, cat
si la Mouse Over (cursorul mouse-ului
pozitionat deasupra elementului respectiv)
- incheierea prezentirii (End Show)

- executarea unei macrocomenzi

- adaugarea unui sunet




	6 Powerpoint_Page_1
	6 Powerpoint_Page_2
	6 Powerpoint_Page_3
	6 Powerpoint_Page_4
	6 Powerpoint_Page_5
	6 Powerpoint_Page_6
	6 Powerpoint_Page_7
	6 Powerpoint_Page_8

